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The title of your 8-page full paper should only have capitals for the first word and the proper nouns
First Authora, Second Author b, Third Author c
aInstitutional Affiliation, City, State/region, Country, Email address
bInstitutional Affiliation, City, State/region, Country, Email address
cInstitutional Affiliation, City, State/region, Country, Email address
ABSTRACT: A full-length paper should have an abstract. The abstract (preferably 100-150 words) should comprise a brief and factual account of the contents and conclusions of the paper, as well as an indication of any new information presented, and its relevance. Complete sentences should be used, without unfamiliar abbreviations or jargon.

1 InTRODUCTION

A full-length paper should have a short introduction. This should state the reasons for the work, with brief reference to previous work on the subject.

1.1 General instructions

Authors of papers for these proceedings have to type them in a form comparable with this    example template to provide a pdf version with a uniform appearance for the proceedings publication. In order to ensure uniform style throughout the volume, all papers are requested to be prepared strictly according to the instructions provided below. The proceedings will be composed of the pdf version of each paper that will be distributed on a USB flash drive. The use of color is acceptable and encouraged to assist in providing meaningful graphics. For the convenience of the authors, this template file for MS Word 2003 (and higher) is provided. The use of only left justification of the document text is recommended.
The directions in this template generally follow the Instructions for Authors given for the Journal of Wind Engineering and Industrial Aerodynamics.

1.2 Type area

The text should be one column and should fit exactly into the type area of 16.51 ( 22.86 cm (6.50” ( 9.00”). For correct settings of margins in the Page Setup dialog box (File menu) see Table 1. 


Table 1. Margin settings for Letter size paper 
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1.3 Style tags for text

The style tags (i.e., Normal text, Heading 1, Figure caption) for this paper have been defined within the template. Authors can access the list of style tags by clicking on the drop-down menu to the right of the AA on the toolbar (see Figure 1 for screen capture).

To apply a style tag to text, highlight the text to be formatted, and then use the pointer to drop the menu and select the style tag to be applied. The text should automatically format to the   specifications of the style tag.
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Figure 1. Screen capture of Style menu.

1.4 Type font, size and spacing

All text should be typed in Times New Roman, 12 pt on 13 pt line spacing except for the paper title (18 pt on 20 pt), author(s) (14 pt on 16 pt), and the small text in tables, captions and references (10 pt on 11 pt). Use plain Times New Roman type except for parameters in mathematics (not for log, sin, cos, ln, max., d (in dx), etc.), Latin names of species and genera in botany and zoology and the titles of journals and books which should all be in italics. Never use bold, except to denote vectors in mathematics. Never underline any text. Use the small font (10 points on 11 points) for tables (Table tag), figure captions (Figure caption tag) and the references (Reference text tag).

First lines of paragraphs are indented 5 mm (0.2”) except for paragraphs after a heading or a blank line (First paragraph tag). Never add any space between lines or paragraphs. Never use letter spacing, and never use two consecutive spaces.

2 Getting started

2.1 Preparing the new file with the correct template

Copy the template file CWE2010_template.doc to your computer or disk. Start by renaming the document by clicking Save As in the menu Files. Put the abstract/paper ID number followed by the presenter family name as the filename (e.g., 123_PresenterFamilyName.doc). Now you can type your paper, or copy the old version of your paper onto this new formatted file. Note that the final file has to be submitted in pdf format.
2.2 Copying old text onto new file

Open both your old file and the new file. Switch between these two with the Window menu.  Select all text of the old file and paste to the bottom of the new file. Check the margin setting (Page Setup dialog box in File menu; see Table 1 for correct settings). 

2.3 Title, author and affiliation

Papers should be headed by a concise but informative title. Only the first word in the title and the first letter of proper nouns (examples: specific people, places or businesses: John Smith, United States, Microsoft) should have a capital. Acronyms like LES or CFD have all capital letters. The title should be followed by the names of authors and by the name and address of the institution in which the work was performed. Also the email address of the authors should be mentioned. This information should be centered on the page. If the address of the author at the time when the paper will appear will be other than that where the work was carried out, this may be stated in a footnote. 

Acknowledgements for financial support should not be made by a footnote to the title or name of the author, but should be included in the Acknowledgements section at the end of the paper.

2.4 First line of text or heading

If your text starts with a heading, place the cursor on the I of INTRODUCTION and type the correct text for the heading. Now delete the word INTRODUCTION and start with the text after a return. This text should have the tag First paragraph.

If your text starts without a heading you should place the cursor on the I of INTRODUCTION, change the tag to First paragraph and type your text after deleting the word INTRODUCTION, but not the return at the end.

3 Layout of text

3.1 Headings

Type primary headings in capital letters Roman (Heading 1 tag) and secondary and tertiary headings in lower case italics (Headings 2 and 3 tags). Headings are set flush against the left margin. The tag will give two blank lines (26 pt) above and one (13 pt) beneath the primary headings, 1½ blank lines (20 pt) above and a ½ blank line (6 pt) beneath the secondary headings and one blank line (13 pt) above the tertiary headings. Headings are not indented and neither are the first lines of text following the heading indented. If a primary heading is directly followed by a secondary heading, only a ½ blank line should be set between the two headings. In the Word program, this has to be done manually as follows: Place the cursor on the primary heading, select Paragraph in the Format menu, and change the setting for spacing after, from 13 pt to 0 pt. In the same way the setting in the secondary heading for spacing before should be changed from 20 pt to 7 pt.

3.2 Listing and numbering

When listing facts use either the style tag List signs or the style tag List numbers.

3.3 Equations

Use the equation editor of the selected word processing program. Equations are not indented (Formula tag). Number equations consecutively and place the number with the tab key at the end of the line, between parentheses. Refer to equations by these numbers. See for example Equation 1 below:
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where ca = interface adhesion; ( = friction angle at interface; and k1 = shear stiffness number.

For simple equations in the text always use superscript and subscript (select Font in the Format menu). For example: From the above we note that sin ( = (x + y)z. Do not embed equations from the equation editor in the text on same line.

3.4 Photographs and figures

Number figures consecutively in the order in which reference is made to them in the text, making no distinction between diagrams and photographs. Figures can be placed either in the body of the text, or all at the end of the text. Figures should fit within the type area width of 16.51 cm (6.50”).

Figures and photographs can be provided in color. Paste copies of the same size onto the typescript where you want them to appear in the text. Do not place them sideways on a page; however, if this cannot be avoided, no other text (except the figure caption which should also be placed sideways) should appear on that page. Figures, etc. should not be centered, but placed against the left margin. If you are placing the figures in the body of the text, leave about two lines of space between the actual text and figure (including caption). Never place any text next to a figure. Leave this space blank. The most convenient place for placing figures is at the top or bottom of the page. Avoid placing text between figures as readers might not notice the text. 
Line drawings (as well as photographic reproductions of these) should be in black (not gray) on white. The minimum size of lettering in figures should be 9 points. Lines should preferably be 0.2 mm (0.1”) thick. Keep figures as simple as possible. Avoid excessive notes and designations.
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Figure 2. Caption of a typical figure. 

Photographs should be provided with good contrast. The proceedings will be distributed on a USB flash drive and color for figures is accepted and recommended where informative. 

3.4.1 Figure captions

Always use the Figure caption style tag (10 points size on 11 points line space). Place the caption underneath the figure. Type as follows: ‘Figure 1. Caption.’ Leave about two lines of space between the figure caption and the text of the paper. Consistency of style is very important. Note the spacing, punctuation and caps in all the examples below.

· Reference to figures in the text: Figure 1, Figures 2-4, 6, 8a, b (not abbreviated)

· Reference to figures between parentheses: (Fig. 1), (Figs 2-4, 6, 8a, b) (abbreviated)

3.5 Tables

Locate tables close to the first reference to them in the text. Careful thought should be given to the layout of Tables (and Figures) so that the significance of the results may be quickly grasped by the busy reader. Often a Table of results can be understood more readily if columns and lines are interchanged. It should also be remembered that the length of a printed page is greater than its width. Tables should be numbered with Arabic numerals (e.g., 1, 2, 3) and should have headings that make their general meaning understandable without reference to the text. The units in which results are expressed should be given at the top of each column (in parentheses) and not repeated on each line of the Table. Avoid abbreviations (except for units) in column headings. Footnotes should be indicated by the use of lower-case letters (a, b, c, etc.), as superscripts without      parentheses. 

Use only horizontal rules: one above and one below the column headings and one at the foot of the Table (Table rule tag: Use the Shift-minus key to actually type the rule exactly where you want it). For simple Tables, use the tab key and not the Table option. Type all text in Tables in small type: 10 on 11 points (Table text tag). Align all headings to the left of their column and start these headings with an initial capital. Type the caption above the table to the same width as the table (Table caption tag). See for example Table 1.

3.6 Conclusions

Conclusions should state concisely the most important propositions of the paper as well as the author’s views of the practical implications of the results.

4 UNITS

Follow internationally accepted rules and conventions: use the international system of units (SI). If other quantities are mentioned, give their equivalent in SI.
5 acknowledgements

This template is based on the template of CWE2006, the successful predecessor of CWE2010. CWE2006 was held in Yokohama and was chaired by Professor Yukio Tamura.
6 References

6.1 Citations in the body of the text
All publications cited in the text should be presented in a list of references following the text of the manuscript. Reference citations in the text should refer to:
1. Single author: the author's name (without initials, unless there is ambiguity) and the year of publication;
2. Two authors: both authors' names and the year of publication;
3. Three or more authors: first author's name followed by 'et al.' and the year of publication.
Citations may be made directly (or parenthetically). Groups of references should be listed first alphabetically, then chronologically. Examples: "as demonstrated (Allan, 1996a, 1996b, 1999; Allan and Jones, 1995). Kramer et al (2000) have recently shown ...." References to a “private communication” are not to be given. A “personal communication” should be referred to only when permission has been obtained from the person who made the personal communication. A reference to “in press” implies that the paper has been accepted for publication.

6.2 References in the reference list

References should be arranged first alphabetically and then further sorted chronologically if   necessary. More than one reference from the same author(s) in the same year must be identified by the letters "a:, "b", "c", etc., placed after the year of publication. The references should be typed in small text (10 pt on 11 pt) and second and further lines should be indented 5.0 mm (0.2”) (Reference text tag). Footnotes and legends should not include bibliographic material, and reference lists should not include material that could more appropriately appear as a footnote.

Examples:

Journal papers:

Tominaga, Y., Mochida, A., 1980. CFD prediction of flowfield and snowdrift around a building complex in a snowy region. Journal of Wind Engineering and Industrial Aerodynamics 81, 273-282.

Monographs, Multi-author volumes, Proceedings:
Filho, S., Bower, D., 1995. The use of predictive bridge management systems to enhance the effective service life, in: Proceedings of the 6th International Conference on Structural Faults and Repair-95, 31-37. Engineering Technics Press, Edinburgh. 

Gould, P.L., 1984. Finite element analysis of shells of revolution. Pitman Advanced Publishing Program, Boston. 

Irwin, G.R. 1956. Onset of fast crack propagation in high strength steel and aluminum alloys. Sagamore Research Conference Proceedings 2, 289-305. 

7 PAPER submittal SHEET
All authors are required to fill out and submit the separate paper submittal sheet that can be downloaded from the website. Please note that there will be no time to allow major revisions to paper contents, language and formatting. The papers must be scientifically sound. Papers should be readable and written in grammatically correct English. The authors have to apply a spell checker to the paper text. The papers have to be formatted according to this template. Due to lack of time to allow major revisions, papers that do not satisfy these criteria will have to be rejected. CWE2010 counts on the assistance of all authors to achieve high-quality proceedings for the symposium.  
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